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Advanced Microsoft Word 2007
Microsoft Word 2007 is one of the more popular programs in the Microsoft Office Suite. 
Microsoft has made some major changes from previous versions of the program. Word 2007 
offers the tools to easily create professional documents using advanced features. 

Basic and intermediate-level functions of the application were discussed in the Introduction to 
Microsoft Word 2007 and Intermediate Microsoft Word 2007 documents. This handout will 
guide readers through some of the advanced functions that Word 2007 provides, such as 
Customizing Word, Mail Merge, and Tracking Changes. Refer to the Contents page for a general 
overview of the topics discussed in this document. 

Customizing Word 2007 
As users become more experienced with Word, they will look for ways to speed up routine tasks, 
saving time that can be used for more productive work. They discover features that they use 
frequently and others rarely. They will develop preferences for what should be seen in the 
menus, toolbars and keyboard shortcuts. This handout explains how to customize these aspects 
of Word. 

VIEWING FORMATTING MARKS 
This allows users to view special characters known as formatting marks in a document that are 
normally not visible. This can be useful when the user wants to view characters such as tabs, 
spaces, or paragraph marks.

To view formatting marks in a document: 
1. Click the Office Button. 
2. Select  in the lower right 

corner. The Word Options dialog box 
opens. 

3. Click the Display button in the left 
column. 

4. Select the formatting marks that should 
be visible (see Figure 1) ► OK button. 

 
Figure 1 - Formatting Marks Options 

SETTING SAVE OPTIONS 
Word 2007 offers users several different options that are applied when a document is saved (see 
Figure 2) designate how items are saved. One feature of the save options automatically saves 
recovery information to help prevent data loss. 

 
Figure 2 - Document Saving Options 

http://www.calstatela.edu/its/docs/pdf/wordxp.pdf
http://www.calstatela.edu/its/docs/pdf/wordxp.pdf
http://www.calstatela.edu/its/docs/pdf/intwordxp.pdf
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Save options are accessed by opening the Word Options dialog box as described in the previous 
section and clicking the Save button in the left column.  

When working on a document, it is best to save it frequently to minimize work lost in the event 
of a system error. A feature built into Word 2007 tells the program to automatically save work at 
a designated time interval (10 minutes by default). To change the time interval, use the Save 
AutoRecover info every: spin box. (Make sure the Save AutoRecover info every: check box is 
checked). The interval can be anywhere from 0 to 120 minutes. When Word 2007 reopens after a 
system error, the recovered file appears in the File Recovery Task Pane. The recovered file may 
contain information that would otherwise be lost. 

Additionally, in this section users can 
designate the format that documents are 
automatically saved (see Figure 3 for the list 
of available formats). Users can also specify 
the location where the AutoRecover file is 
stored and the default location where all 
files are saved (see Figure 2 

 
Figure 3 - Available Document Formats 

NOTE: AutoRecover does not replace the need to save work periodically! 

Creating Keyboard Shortcuts 
Users may sometimes prefer working with the keyboard instead of choosing commands with the 
mouse. It is possible to add shortcuts to existing buttons, and include symbols and special 
characters. 

NOTE: All shortcut keys begin with [Alt], [Ctrl] or a function key [F1, F2, F3…]. 

To assign keyboard shortcuts to existing buttons and commands: 
1. Click the Office Button ►  button. The Word Options dialog box opens. 
2. Click the Customize button in the left column. 
3. Click the Keyboard shortcut:  button. The Customize Keyboard dialog box 

opens (see Figure 4). 
4. Navigate to the category and command to which a keyboard shortcut will be assigned. 
5. Click inside the Press new shortcut key: textbox. 
6. Press the sequence of keys that will define the new shortcut. The sequence will appear in 

the textbox. 
7. Click the  button ►  button.  
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Figure 4- Customize Keyboard Dialog 

Using Mail Merge 
The Mail Merge function provided by Word 2007 enables the user to create letters, faxes, e-mail 
messages, envelopes, labels and directories once and use them many times with the data saved in 
a mailing list database or an address list in the Microsoft Outlook Contacts List. With this 
feature, the user can create and send projects like a direct mail campaign to many people or 
organizations. It can also be used to make mailing labels to affix to catalogs or an address listing 
of all clients in various databases. 

USING THE MAIL MERGE WIZARD 
The Mail Merge Wizard provides all the basic steps to create, open and modify both the main 
document and the data source. Some of the terms used in the Mail Merge Wizard are described 
in Table 1. The Mail Merge task pane provides instructions for each step in the process. In 
addition, it is possible to go back to any previous step to review or modify the mail merge. 

Table 1 – Terms about Using Mail Merge Wizard 
Terms Description 

Main document 

Contains the information common to all merged documents. 
It can be a letter, email, envelope, or label into which the 
data will be merged. It can conclude text, images, borders, 
colors, shades, tables and more. 

Source file 
The file from which the merge data is taken. It contains the 
variable information that will be inserted into the merge 
fields in the main document. 

Merge fields 
Identifiers inserted in the text that indicate to Word the 
position and type of data to be inserted at that point in the 
document. 

Address block Includes name and address information. 

Greeting line Adds the opening salutation, along with the name of the 
recipient selected. 
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To use the Mail Merge Wizard:
1. Select the Mailings tab on the Ribbon. 
2. Click the Start Mail Merge drop down 

arrow in the Start Mail Merge group. 
3. Click the Step by Step Mail Merge 

Wizard option in the drop-down menu 
(see Figure 5). The Mail Merge task 
pane opens (see Figure 6). 

4. Select the type of document in the 
Select document type section. 

5. Click the  link to 
advance to step 2 (see Figure 7). 

 
Figure 5 - Start Mail Merge Drop-Down Menu 

 
Figure 6 - Mail Merge Wizard Step 1 

 
Figure 7 - Mail Merge Wizard Step 2 

6. Choose the appropriate option in the Select starting document section (see Figure 7). 
7. Click the Next: Select recipients link (see Figure 8). The third step of the Mail Merge 

process opens (see Figure 8).Word 2007 provides three options to select the recipients; 
two of the methods are detailed in the following sections of this handout. 

Typing a New List 
The Type a new list option allows users to create a new list of Mail Merge recipients. 

To type a new list: 
1. Click the Type a new list option button in the Select Recipients section of the Mail 

Merge task pane. 
2. Click the  link to open the New Address List dialog box (see Figure 9). 
3. Enter the information for the person or company. 
4. After completing the record, click the New Entry button to add a record. 
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NOTE: Clicking the Customize Columns… button allows the user to add, delete, rename and reorder 
fields (see Figure 9). 

5. When finished adding to the new list, click the OK button to close the dialog box. The 
Save Address List dialog box opens. 

6. Enter a name for the file and click the Save button. The Mail Merge Recipients dialog 
box opens (see Figure 10). The information is displayed in the Mail Merge Recipients 
dialog box allows users to sort, rearrange and select or deselect recipients.  

NOTE: Users can edit the list by selecting the list in the Data Source section and clicking the 
Edit button. The Edit Data Source dialog box will open (it looks and functions exactly the same 
as the New Address List dialog box). 

7. When finished selecting recipients, click the OK button.

 
Figure 8 - Mail Merge Wizard Step 3 

 
Figure 9 - New Address List Dialog Box 

 
Figure 10 - Mail Merge Recipients Dialog Box
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Figure 11 - Mail Merge Task Pane after Recipient List 

is selected 
 

Figure 12 - Using an Existing List 

Using an Existing List 
Using an existing list allows the users to use an existing file as data source that contains the 
information to be merged into a document, for example, a Microsoft Excel worksheet or a 
Microsoft Access database. 

To use an existing list: 
1. Select the Use an existing list option button in the Select recipients section of the task 

pane (see Figure 12). Select the  link on the task pane. The Select Data Source 
dialog box opens. 

2. Navigate to where the list is stored, select the data list and open the file. The Mail Merge 
Recipients dialog box opens (see Figure 10). 

NOTE: If a data source is opened that contains multiple tables (such as a database file), the Select 
Table dialog box will open first. After selecting a table, the Mail Merge Recipients dialog box will 
open. 

3. Select the recipients by checking the check box next to their name. When finished, click the OK 
button. 

INSERTING MERGE FIELDS INTO A DOCUMENT 
Once the document and the recipients have been selected, the next step involves adding the 
placeholders in the document where the data will be inserted for individual recipients. 

To add Merge Fields: 
1. Click the  link to  
2. Position the insertion point to the desired location of the first merge field in the 

document. 
3. In the Write your letter section of the task pane (see Figure 13), click the necessary link 

to complete the letter. 
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Table 2 describes the different types of fields that can be inserted into a document.  

Table 2 - Merge Fields that can be inserted in the document (Wizard step 4) 
Fields Description 

Address 
Block 

Displays the Insert Address Block dialog box so that the user can 
add name, address and city, state and ZIP code at the insertion 
point. 

Greeting 
Line 

Displays the Greeting Line dialog box that allows the user to 
select the salutation to be used as well as the format for the 
recipient name. 

Electronic 
Postage 

Enables the user to work with electronic postage if that feature 
is installed. 

More Items Displays the Insert Merge Field dialog box, giving the user the 
option of adding additional fields to the main document. 

NOTE: Clicking the link for an item will open its corresponding dialog box (see Figure 14, Figure 
15, and Figure 16), from which the desired formats and options can be selected.

 
Figure 13 - Mail Merge Wizard 

Step 4 
 

Figure 14 – Insert Address Block Dialog Box 

4. If the common items do not meet the needs of the user, click the More items... link. The 
Insert Merge Field dialog box opens (see Figure 16) and all the fields in the list will be 
available for use. 

5. Select the field(s) to insert and click the Insert button ► Close button. 

NOTE:  Users can also open the dialog boxes by clicking the appropriate button in the Write & Insert 
Fields group on the Mailings tab of the Ribbon. When inserted, a merge field is enclosed in chevrons 
(e.g., «First_Name» «Last_Name»).
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Figure 15 - Insert Greeting Line Dialog Box 

 
Figure 16 - Insert Merge Field Dialog Box 

PREVIEWING MERGED DATA 
Before actually performing the mail merge, preview the merged document and check for 
formatting and spelling errors. If an error is found in the main document, correct it. Also, correct 
it in the data source if there will be another merge. 

Once the letter is formatted to the desired specifications, click the  link at 
the bottom of the task pane to go to the Step 5 of Mail Merge Wizard (see Figure 17).

 
Figure 17 - Mail Merge Wizard Step 5 

 
Figure 18 - Mail Merge Wizard Step 6 

To preview merged data using the controls in the task pane: 
1. Click the Forward arrow   to preview the next merged records. 
2. Click the Back arrow   to preview the previous records. 
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NOTE: Once the merge has been completed, the user can navigate through all of the recipients to view 
their copy of the document. Use the Next Record  or Previous Record  buttons on the Mail Merge 
toolbar to preview merged records. 

To locate a particular recipient in a list click the  link on the Mail Merge Wizard. 
Click  button in the Make changes section of the task pane to remove a 
recipient from the current merge operation.
The merge can be evaluated for errors by clicking 
the  button in the Preview Results 
group on the Mailings tab of the Ribbon. The 
Checking and Reporting Errors dialog box will 
open (see Figure 19) and the user should select the 
necessary option button ► OK button. 

NOTE: The second option, which is the default, 
performs the merge but alerts the user immediately 
whenever an error is found. This is the 
recommended option for first-time users. 

 
Figure 19 - Checking and Reporting Errors 

Dialog Box 

MERGING TO A NEW DOCUMENT 
The final step in the mail merge process involves printing, sending or saving the document with 
the merge data intact. Click the  link in the task pane to advance to the final 
step of the merge (see Figure 18). Users can also click the Finish & Merge drop-down arrow in 
the Finish group on the Mailings tab of the Ribbon (see Figure 20).

 
Figure 20 - Finish & Merge Drop-Down Menu 

 
Figure 21 - Merge to Printer Dialog Box 

NOTE: Selecting the  link in the Mail Merge task pane automatically sends the 
merged letters to a new document so that changes can be made to individual letters. Changes made to 
individual letters in the merged document will not be saved back to the main document or to the data 
source. Once the changes have been made, save the merged document or send the letters to the printer. 

To select merge print options: 
1. Click  link on the Mail Merge task pane or select  from the Finish 

& Merge drop-down menu. The Merge to Printer dialog box opens (see Figure 21). 
2. In the Print records section, select a desired option. The All option will print all records 

in the current document, the Current Record option will print only the displayed record, 
and the From: and To: option will specify a page range in the document ► OK button.
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To merge to a new document select the 
 link. The Merge to New 

Document dialog box opens (see Figure 22). 
In the Merge to New Document dialog box 
(see Figure 22), select the records to merge 
then click the OK button.     

 
Figure 22 - Merge to New Document Dialog Box

To merge to E-mail: 
1. Select the  from 

the Finish & Merge drop-down 
arrow in the Finish group on the 
Mailings tab of the Ribbon (see 
Figure 20). The Merge to E-mail 
dialog box opens (see Figure 23). 
This type of merge process involves 
putting the source data together with 
the main document in e-mail 
messages. 

2. Click the To: down arrow to display 
the choices for the field containing 
the e-mail address to which the 
messages will be sent. 

 
Figure 23 - Merge to E-mail Dialog Box 

3. Enter a subject in the Subject line: textbox to tell recipients something about the 
incoming message. 

4. In the Mail format: drop-down list, select the Attachment, HTML or Plain Text option 
to control the format of the e-mail messages. 

5. In the Send records section, select the records to send ► OK button. 

Tracking Changes 
Many finished documents reflect the ideas, contributions and alterations from not only a single 
person, but instead, a group of people. A single document may be composed by one writer, 
modified by an editor, commented on by a technical reviewer and inspected and approved by a 
project manager. In Word 2007, numerous people can review the same document and 
incorporate their changes and comments with the changes and comments from other people. This 
section will demonstrate some of the markup features and reviewing options in Word 2007 that 
will assist collaboration efforts when working with others on documents. 

MARKUP TOOLS 
The track changes feature records editing changes made to a document including deletions, 
added text, and formatting. Word 2007 can monitor changes from multiple reviewers and the 
changes can later be evaluated, accepted or rejected on a case-by-case or global basis. Most of 
the main collaboration features can be accessed from the groups on Review tab of the Ribbon 
(see Figure 24). Table 3 describes some of the buttons found on the Review tab. 
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Figure 24 - Groups in the Reviewing Tab on the Ribbon 

Table 3 – Description of Select Tools on the Review tab of the Ribbon 
Button Name Description 

 
Display for 

Review 
Controls how Word displays changes and 
comments in the current document. 

 Show 

Accesses a drop-down menu that enables 
the user to configure the display and 
option settings for comments, reviewers 
and tracked changes. 

 
Previous 

Jumps to the previous tracked change or 
comment in the current document 
relative to the insertion point. 

 
Next 

Jumps to the next tracked change or 
comment in the current document 
relative to the insertion point. 

 

Accept 

Accepts a selected tracked change in 
the current document or enables all 
changes to be accepted at once. 

 

Reject 

Rejects a selected change, deletes a 
selected comment and returns the text 
to its original state or enables the 
reader to reject all changes or delete 
all comments at once. 

 

New Comment 

Inserts a new comment. Clicking the 
down arrow allows editions to be made, 
delete comments, or record a voice 
comment. It is shown in the reviewing 
pane or in a margin balloon. 

 

Track 
Changes 

Controls whether the Track Changes 
feature is turned off or on. 

 
Reviewing 

Pane 

Shows or hides the reviewing pane, 
which displays the complete text of 
tracked changes and comments. 

MANAGING COMMENTS 
The use of comments enables reviewers to annotate a document with suggestions and queries 
without changing the document. Comments will display differently depending on the display 
mode the document is in. The display mode is changed by using the Display for Review drop-
down list (see Table 3). If the Display for Review drop-down list is set to Original or Final, then 
comments will be displayed in the Reviewing Pane. If the Display for Review drop-down list is 
set to Original Showing Markup or Final Showing Markup, then comments will be displayed 
in an expanded right margin of the document. 
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Configuring User Names for Reviewing 
When working in a group, each person collaborating on the document must properly configure 
their user name so that the reviewers will know who made each comment. Before inserting 
comments, the user needs to tell Word 2007 how to identify the created comments.  

To set user name information: 
1. Click the Office Button and open the Word Options dialog box. 
2. Make sure the  options are selected. 
3. Change the name and initials in the  section (see Figure 

25). 

 
Figure 25 – Word Options Dialog Box (User Information) 

NOTE: If using someone else’s computer to review a document, it is possible to change the name on 
the Word Options dialog box before beginning work without affecting existing documents. When 
finished, reconfigure the user information to the original information. 

Managing Reviewers in a Document 
By default, Word 2007 automatically uses a different color to identify the comments of each 
reviewer and tracked changes in a document. If viewing a document that is color-coded for a 
number of reviewers, the user can quickly see which colors are currently assigned to which 
reviewers.

To view reviewer color codes: 
1. Click the  drop-down arrow 

on the Tracking group ► . 
The list of reviewer names and their 
associated colors check will be 
displayed (see Figure 26). 

2. Select or deselect the check boxes next 
to the name of a reviewer to specify 
whether comments and tracked changes 
are from that reviewer are displayed in 
the current document. 

 
Figure 26 – Submenu of Reviewers 

Inserting Standard Comments 
Comments can be inserted into the document as text comments, voice comments, and 
handwritten comments. 

To insert a comment: 
1. Position the insertion point for the comment. 
2. Select the Review tab on the Ribbon. 
3. Click the New Comment button in the Comments group (see Figure 24). A new 

comment will open in Markup Area (an expanded right margin) of the document and the 
specific location of the comment in the line will be highlighted (see Figure 27). 
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Figure 27 - New Comment Balloon 

4. Type the comment text in the comment balloon, and then click outside of the balloon or 
reviewing pane to complete the comment. 

NOTE: It is possible to change a comment after creating it, by clicking inside the comment balloon 
and editing the text. 

Showing and Hiding Balloons 
If the user prefers to work with the reviewing pane instead of the balloons, the balloons can be 
turned off. 

To turn the balloons off: 
1. Select the Reviewing tab on the Ribbon. 
2. Click the Track Changes drop-down arrow in the Tracking group (see Figure 24). 
3. Select the  from the drop-down menu (see Figure 28). The Track 

Changes Options dialog box will open. 
4. Click the  drop-down arrow in the Balloons section. 
5.  Select the “Never” option ► OK button.

 
Figure 28 - Track Changes Drop-Down Menu 

 
Figure 29 - Balloons Section of Track Changes Options 

Dialog Box 

NOTE: If the balloons are hidden, the comment marker will show up in the text where the comment 
was inserted (see Figure 30). The full content of a comment can be displayed as a ScreenTip when 
the mouse is positioned over the comment marker and (see Figure 30 and Figure 31).

 
Figure 30 - Comment Marker When Balloons are 

Turned Off 

 
Figure 31 - ScreenTip Displaying a Comment 

When Balloons are Turned Off 

Reviewing Comments 
When reviewing comments that have been inserted into the document, it is possible to review the 
comments only, without displaying tracked changes. 

To display comments only: 
1. Select the Review tab on the Ribbon. 
2. In the Tracking group, make sure that either Final Showing Markup or Original 

Showing Markup is selected in the Display for Review  drop-down list box.
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3. Click the  drop down 
arrow in the Tracking group and 
make sure that the  option 
is the only item selected in the drop-
down menu. 

 
Figure 32 - Show Markup Drop-Down Menu 

Deleting Comments 
When reviewing a document, some comments may need to be deleted. Comments can be deleted 
all at the same time, or individually reviewer.

To delete a single comment: 
1. Right click a comment balloon. 
2. Select the  command. 

Or 
1. Select a comment balloon. 
2. Click the  button in the 

Comments group 

To delete all comments in the document: 
1. Select a comment balloon. 
2. Click the  drop-down arrow in 

the Comments group. 
3. Select the 

 option. 
 

Figure 33 - Comment Delete Drop-Down Arrow

Inserting Voice Comments 
Besides adding standard comments, users can include voice comments within documents. To 
create voice comments, the computer must have a sound card and a microphone. Likewise, 
others who review the document and listen to voice comments must be using a computer 
equipped with a sound card and speakers or headphones. Before voice comments can be used, 
the Quick Access Toolbar must be customized as described in the Intermediate Word Handout. 

NOTE: The Voice Comment button that is placed on the Quick Access Toolbar can be found in the 
 list that is accessed from the  drop-down menu in the 

Word Options dialog box. 

To create a voice comment: 
1. Select the insertion point where the comment will be placed 
2. Click the Insert Sound Object button  on the Quick Access Toolbar. The Sound 

Object in Advance… dialog box opens (see Figure 34). 
3. Click the red Record button and then speak into the microphone to record comments. 
4. Click the Stop button when finished and close the sound recorder.
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Figure 34 - Sound Object in Advance Dialog Box 

 
Figure 35 - Voice Comment Icon 

A Voice Comment icon (see Figure 35) will be placed at the insertion point. To play the voice 
comment, right-click the icon and select  ► . 

TRACKING CHANGES 
When the Track Changes feature is turned on, Word 2007 records the deletions, insertions and 
formatting changes made by each reviewer who modifies the document. Track changes can be 
enabled or disabled by 

• Right-click the Word Status Bar 
and make sure the  
option is checked, and then click 
the  button on the 
Word Status Bar (see Figure 
36). 

Or 
•  Press the [Ctrl + Shift + E] key 

combination. 
Or 
• By clicking the Track Changes 

button on the Review tab of the 
Ribbon. 

 
Figure 36 - Customize Status Bar Menu 

Word 2007 marks tracked changes in a document as described in Table 4. 
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Table 4 – Tracked Changes Description 
Tracked Changes Description 

Added text Appears in the reviewer’s color with 
underlining. 

Deleted text 
Remains visible, but is displayed in the 
reviewer’s color with a strikethrough line 
indicating the deletion. 

Text added and then deleted 
by the reviewer 

Is displayed as if the text was never added. 

When working with a document that has been modified by a reviewer(s), use the Display for 
Review drop-down list on the Review tab of the Ribbon to display the changed document in four 
views (see Table 5). 

Table 5 – Views Description 
Views Description 
Final Showing 

Markup 
Shows deleted text in the balloons and displays inserted text 
and formatting changes in the line. 

Final Shows how the document would appear if you accepted all 
changes. 

Original 
Showing Markup 

Shows the inserted text and formatting changes in balloons and 
shows deleted text in line with strikethrough lines. 

Original Shows the original, unchanged document so that you can see how 
the document would look if you rejected all the changes. 

Comparing and Combining Documents 
The user can compare different versions of the same document and then decide which changes 
need to be kept. If several drafts of the same document have been created, the user may want to 
compare the differences. It is also possible to compare changes made to the same document by 
different people. 

Combining incorporates all changes made to the various versions or copies of the original 
document into one document so that all the changes can be reviewed in one place. The user can 
select one of three options when combining documents: the changes can be shown in the original 
document, they can be shown in the revised document, or a new document can be created that 
will show the changes. These options are selected in the  section of the Combine 
Documents dialog box (see Figure 37). 

The Compare Documents and Combine Documents are the same (see Figure 37) except for the 
functions they perform. To access them, click the  drop-down arrow on the Review tab of 
the Ribbon and select either  or . The different comparison options can be set 
in the  section of each dialog box. 

NOTE: If the documents all have the same file name, they must be stored in different locations so that 
none of them will be overwritten. 
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Figure 37 - Combine Documents Dialog Box 

Accepting and Rejecting Proposed Edits 
After a document containing tracked changes has been reviewed, the user can incorporate the 
edits by accepting or rejecting the changes. When incorporating edits, the user can address each 
edit on a case-by-case basis or accept multiple changes at one time. 

NOTE: Before starting to accept and reject tracked changes and comments, consider saving a version of 
the document with all the tracked changes and comments intact. If users want to return to the originally 
marked-up version of the document there will be a back-up copy. 

ADDRESSING TRACKED CHANGES ONE AT A TIME 
After the changes to work with are displayed, the user can move from tracked change to tracked 
change using the  and  buttons (see Table 3) on the Reviewing tab of the Ribbon. It is 
possible to jump from comment to comment as well. 

A tracked change can be managed in either of the following ways: 
• Right-click on a change (in the document body, in the reviewing pane, or in a balloon) 

and accept or reject the change. 
• Click on a change and click the Accept or Reject button (see Table 3) in the Reviewing 

tab of the Ribbon. 

After a change is accepted or rejected, Word 2007 displays the revised text as standard text. 

ACCEPTING AND REJECTING ALL TRACKED CHANGES AT ONCE 
At times, the user might want to accept or reject all changes in a document by executing a single 
command. 
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To accept or reject tracked changes: 
1. Click either the Accept or Reject drop-down arrow on the Reviewing tab of the Ribbon. 
2. Select the appropriate command from the drop-down menu (see Figure 38 and Figure 

39).

 
Figure 38 - Accept Change Drop-Down Menu 

 
Figure 39 – Reject Change Drop-Down Menu 

3. Select the Accept All Changes in Document or Reject All Changes in Document 
option. 

Creating and Working with Macros 
A macro automatically executes a series of previously recorded and saved commands. Users can 
create macros for repetitious tasks that are performed frequently using the same sequence of key 
strokes. Since a macro can be played with relatively few steps, macros can save time, especially 
when the task involves a large number of steps. When macros have to perform a series of 
repetitive steps, users can be assured that the task is performed in exactly the same way each 
time. Macros ensure consistency and accuracy. 

Macros are typically created to perform the following tasks: 
• Automate a complex series of steps. 
• Combine multiple commands (such as formatting and inserting tables with a single 

command). 
• Accessing menu commands and submenu commands quicker. 
• Speed up editing. 
• Formatting procedures. 

RECORDING A MACRO 
The macro recorder in Word 2007 acts like a tape recorder. When a macro is recorded, it is 
possible to use the mouse to click commands and options, but not to select text. The user must 
use the keyboard to record those actions. For example, the user can use [F8] to select the 
beginning of the text to select, and then press [End] to move the cursor to the end of the line.
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Figure 40 - Macros Drop-Down Menu 

 
Figure 41 - Record Macro Dialog Box 

Before recording a macro, plan the steps and commands for the macro to perform. If the user 
makes a mistake when recording the macro, corrections made will also be recorded. The user can 
edit the macro later to remove unnecessary steps that were recorded. 

To record a macro: 
1. Select the View tab on the Ribbon. 
2. Click the Macros drop-down arrow in the Macros group (see Figure 40). 
3. Select the  option. The Record Macro dialog box opens (see Figure 41). 

NOTE: The macro name must begin with a letter; it can contain numbers; it can contain up to 80 
letters and numbers. The macro name cannot contain spaces or symbols. Use of Underscore “_” 
character to separate words is permitted. 

4. In the Store macro in: list, make sure that the drop-down list displays the template or 
document in which to create the macro, e.g. All Documents (Normal.dotm). 

5. Review the text in the Description: textbox. By default, Word 2007 provides the date and 
author of a macro in the Description: box. 

6. Click the OK button. The Record Macro dialog box closes and the cursor shape changes. 

NOTE: The macro is available only when the document or template in which it is stored is open. 
Macros are normally stored in the Normal template, which means that the macros can be run at any 
time. The locations macros can be stored at are listed in Table 6. 

Table 6 – Locations for Storing Macros 
Location Description 

Active 
document 

If the macro is to be used in a single document, the macro can 
be stored directly in the document. When this option is 
selected, the macro will run only when the document is the 
active document. 

All documents 
(Normal.dotm) 

A macro can be stored in the “Normal” template, thereby making 
the macro available to all open files. By default, Word stores 
macros created in the “Normal” template. 

Template 

A macro can be stored in a template other than the “Normal” 
template if a template is attached to the current document or 
opened when the macro is created. When this is done, the macro 
is available only when the template is opened or attached to 
the active document. 
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7. Perform the sequence of steps.

NOTE: If the user needs to perform steps that 
should not be included in the macro, recording 
can be paused by clicking the Macros drop-
down arrow and selecting the  
option (see Figure 42). 

 
Figure 42 - Macros Drop-Down Menu (while Recording) 

8. When the sequence of steps has been recorded, click the Macros drop-down menu and 
select the  option (see Figure 42). 

RUNNING A MACRO 
When a macro is run, it executes each of the recorded steps in the order that they were recorded. 
Regardless of the document that was open when the macro was created, the macro can run in any 
document, as long as it is stored in the Normal template.

To run a macro: 
1. Select the View tab on the Ribbon. 
2. Click the Macros drop-down arrow. 
3. Select the  option. The 

Macros dialog box opens (see Figure 
43). 

4. Select the macro in the  
list box. 

5. Click the Run button. The macro 
will run and the Macros dialog box 
will close. 

 
Figure 43 - Macros Dialog Box 

EDITING A MACRO 
The user can edit a macro, either to correct a mistake or to change a procedure in it. To make 
extensive modifications to procedures, however, the user must be skilled in using Visual Basic 
programming language. Macros can be edited by performing the same steps to run the macro (as 
described in the previous section) but instead of clicking the Run button, click the Edit button. 
The macro will open in the Visual Basic editing window. 

ADDING THE MACRO DROP-DOWN MENU TO THE QUICK ACCESS TOOLBAR 
The Macros drop-down menu can be placed on the Quick Access Toolbar for quicker user 
access. The Quick Access Toolbar must be customized as described in the Intermediate Word 
Handout. 



Advanced Microsoft Word 2007 - 22 

NOTE: The Macros drop-down menu that is placed on the Quick Access Toolbar can be found in the 
 list that is accessed from the  drop-down menu in the Word Options 

dialog box. 

DELETING A MACRO 
A macro can be deleted if it is no longer in use. Deleting a macro removes it from the  
list box in the Macros dialog box. Macros are deleted by performing the same sequence of steps 
in the Running a Macro section of this document, but instead of clicking the Run button, 
click the Delete button and then click the Yes button on the warning message box. 

Managing Document Properties 
Document properties are the information attached to a workbook to summarize its purpose or to 
help users locate it. Usually this information can be found in the Properties dialog box or the 
Document Information Panel, which contains fixed and modifiable information. Fixed 
information includes statistics such as the size of the document, the date the document was 
created, modified, date last accessed and the name of the last person who saved the document. 

Document properties can be viewed and modified by opening the Document Information Panel 
(see Figure 44) beneath the Ribbon and, if necessary, the Properties dialog box (see Figure 45). 
Partial properties can also be displayed using the Properties view in the Open dialog box of a 
closed document (see Figure 46). 

 
Figure 44 - Document Information Panel 

To view the Document Information Panel: 
1. Click the Office Button. 
2. Select the Prepare option. 
3. Select the  option. 

To open the Properties dialog box: 
1. With the Document Information Panel open, click the  drop-down 

arrow. 
2. Click the  option
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.

 
Figure 45 - Properties Dialog Box 

 
Figure 46 - Properties View in the Open Dialog Box 

To view partial properties from the Open dialog 
box: 

1. Click the Office Button. 
2. Select the  option. The Open dialog 

box will appear. 
3. Click the Views drop-down arrow (see 

Figure 47). 
4. Select  from the drop-down list. 
5. If necessary, navigate to the drive and folder 

where the file is located. 
6. Single-click the file to activate the partial 

properties panel (see Figure 46). 
 

Figure 47 - Views Drop-Down List 

NOTE: If the computer is set to open files using a single click, step 6 above will open the file without 
displaying the partial list of properties. It is also possible to view a brief properties description (size, 
type, date modified) of the document by selecting Details from the Views drop-down list of the Open 
dialog box. 

EDITING DOCUMENT PROPERTIES 
The complete document properties can be found in the Properties dialog box (see Figure 45) in 
the Summary or Custom tabs. In the Summary tab there are preset fields where a user can insert 
new information or modify existing information. The user can also enter the title and subject 
text, enter or change the name of the author, assign categories or keywords or include comments. 
In addition to the existing fields, there are options in the Custom tab to create new fields and 
field information. 
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Using SmartArt 
SmartArt is a new feature in Word 2007. SmartArt is a visual representation of information and 
ideas that combines text and graphics so that information can be shown in a more visually 
enhancing manner. Figure 48 is an example of SmartArt. When the SmartArt graphic is placed 
in a document, text can be automatically entered. The advantage to using SmartArt is that the 
user does not have to draw any of the graphic shapes. They are automatically created when the 
graphic is selected. The SmartArt graphic can be formatted if a different appearance is desired.

 
Figure 48 - Example of SmartArt 

 
Figure 49 - Choose a SmartArt Graphic Dialog Box 

To incorporate a SmartArt graphic onto a document: 
1. Select the Insert tab on the Ribbon. 
2. Click the SmartArt button in the Illustrations group. The Choose a SmartArt Graphic 

dialog box opens (see Figure 49).  
3. Select the category in the left column of the dialog box; select the graphic in the List 

section of the dialog box. A description is provided in the preview pane on the right side 
of the dialog box (see Figure 49). 

4. After the graphic is selected, click the OK button. Text can then be entered by clicking in 
any part of the graphic where “[Text]” appears 

NOTE: Text can also be entered by clicking the Expand/Collapse button  on the left edge of the 
graphic and opening the Type your text here dialog box (see Figure 51). Click the Close button  
when finished and the text will automatically appear in the graphic.
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Figure 50 - Sample Blank SmartArt Graphic 

 
Figure 51 - Type Your Text Here Dialog Box 

To format the graphic: 
1. Select the object so that the sizing 

handles are visible as in Figure 50. 
2. Right-click anywhere inside the 

object and select the  
option. The Format Shape dialog 
box opens (see Figure 52). 

3. Choose the appropriate options until 
the desired formatting effects are 
displayed by the graphic. 

4. When finished formatting the 
graphic, click the Close button. 

 
Figure 52 - Format Shape Dialog Box 

Using the Version Compatibility Checker 
A new feature in several of the Microsoft Office 2007 applications is the Compatibility Checker. 
The Compatibility Checker will inspect documents created in Word 2007 to see if the 
worksheets contain objects such as SmartArt that are incompatible with earlier versions of Word.
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To run the Compatibility Checker: 
1. Click the Office Button. 
2. Select the  option. 
3. Select the Run Compatibility Checker 

option. The Microsoft Office Word 
Compatibility Checker dialog box opens 
(see Figure 53). Any incompatible items 
will be identified in the dialog box. 

4. Click the OK button to close the dialog 
box. 

NOTE: If no incompatible items are identified 
in the workbook, the dialog box will still open 
and indicate that no incompatible items were 
found. 

 
Figure 53 - Microsoft Office Excel Compatibility 

Checker Dialog Box 

By default, Word will check the backward compatibility of any presentation when it is saved in 
the  format. If no incompatible items are found, the Microsoft Office Word 
Compatibility Checker dialog box will not open. If an incompatible item is identified and the 
user proceeds to save the document, the incompatible item will be degraded so that the document 
will open in an earlier version of Word. For example, SmartArt objects will be converted to non-
editable images that will open in the earlier version. 

Using the Document Inspector 
Another new feature in Microsoft Office 2007 applications is the Document Inspector feature. 
Documents may sometimes contain hidden or personal information that a user may be unaware 
of, or does not want to share with others if copies of the document will be distributed. Personal 
information can also become embedded in the form of metadata when document properties are 
set. The Document Inspector will identify any potential information that a user may want 
removed before distributing a document and give the user the option to remove it.  

To use the Document Inspector: 
1. Click the Office Button. 
2. Select the  option. 
3. Select the  option. The Document Inspector dialog box opens (see Figure 

54). 
4. Users are presented with six categories of information that the Document Inspector will 

search for. Each of the categories can be either selected or deselected by the user with the 
associated check boxes. 

5. When the categories have been selected, click the Inspect button. 
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Figure 54 - Document Inspector Dialog Box 

6. When the Document Inspector completes its search, the Document Inspector Results 
dialog box will open (see Figure 55).  

7. If any potential personal information is found within the document, the user can choose 
to ignore it or eliminate it by clicking the Remove All button. 

8. The user can re-inspect the document by clicking the Reinspect button, or, if no further 
actions are needed, click the Close button. 

 
Figure 55 - Document Inspector Results Dialog Box 
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